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Livestock Manure N Farm Limit

The Nitrate Pollution Prevention Regulations 2008 establishes a rule which limits the loading of livestock
manure to the land on farms in England and Wales. In any year beginning 1 January, the total amount of
nitrogen in livestock manure that is applied to a farm, whether directly by grazing animals or by
spreading, must not exceed 170 kg N multiplied by the area of the farm (in hectares). If the farm has an
approved application for derogation, the limit is increased to 250 kg N multiplied by the area of the farm
(in hectares).

The nitrogen from manufactured fertiliser, and any other organic manure that does not originate from
livestock (e.g. sewage sludge, compost), does not count towards the limit.

For details of this rule, see the NVZ Guidance available from the Library menu.

The PLANET Livestock Manure N Farm Limit module calculates the N capacity and N loading of a farm
and will help assess if the farm is compliant with this limit.

Important

The information supplied in the PLANET software is for guidance purposes only and is not intended to
fully substitute for professional agricultural advice. The specific statutory elements concerning water and
nitrates are set out in the relevant national legislation land and you should refer to this legislation to find
out exactly what you must do. The nutrient recommendations provided by PLANET are in line with
national industry standard guidance. If in doubt, farmers should seek help from a qualified adviser.

The user is responsible for ensuring the accuracy and completeness of all data entered and used by
PLANET, and for any commercial decisions taken based on any of the PLANET recommendations or
other outputs of this software. Use of the PLANET software is subject to the terms and conditions of the
PLANET User Licence.

PLANET v3 has been developed by ADAS and SRUC with funding and support from Defra and the
Scottish Government. The software is maintained by ADAS. For further information, visit
www.planet4farmers.co.uk or ring the PLANET Helpline on 08453 451302.
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Getting started

To use this module, you must first either create a new farm file or open an existing farm file. If you are
starting a new file, then as a minimum you must enter the Farm name and STD code in the Farm Details
tab before you can open the module — but you do not need to enter any other information. You will be
prompted to save any changes before you enter the module.

To use the module, select the Livestock Manure N Farm Limit icon E from the task bar at the top of
the screen, or select Livestock Manure N Farm Limit from the View menu.

The module will appear with three tabs (screens).
e Farm and Livestock Details
e Imports and Exports

e NVZ Compliance

You will then need to enter information for your farm into the Farm and Livestock Details tab, and then
into the Imports and Exports tab. The NVZ Compliance tab is the output tab providing calculated values
for the permitted livestock manure N capacity and the calculated N loading of the farm.

Further information to help with data entry is provided throughout PLANET by hovering over column

headers that have an icon, or by clicking in any data entry cell and then pressing the F1 key. This
will take you to Help about the current screen.

Important. You can only save one set of data in this module. For instance, if you enter data for a
calendar year then this will be saved on your computer. However, if you then edit this data (e.g. for a
later calendar year) the original data will be overwritten and only the new data will be saved. Therefore, if
you wish to keep a permanent record of the PLANET calculation and report for a particular calendar
year, you should either print out a hard copy of the PLANET report before making any edits to the data,
or use the Save As function in the File menu to save each set of data as a separate Farm file which you
will need to name individually.
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Farm and Livestock Details Tab

Lﬂ PLANET - Livestock Manure N Farm limit for calendar year 2010

Fiz Yiew Unts Tools Library  Help

=22 avsAlN | =pofEe | 1@

Farm Details

Calendar pear : 2010 = i Does the fam have derogation Ner

i Area of faimed land in an NYZ EI| ha Permilted livestock manure total N capacity 18600| kg Ny
i Area of faimed land not in an NVZ 2000 ha
Total area of farmed land 10000| ha
Livestock Details Imports and Exports NVYZ Compliance
Livestock gioup | i Livestock type i Awverage number i Occupancy i M standaid  Total N produced
for year &

*

» Cattle 1 bull for breeding, 25 months and over 1 480 48
Cattle 1 calf, up to 3 monthe &0 84 420
Cattle 1 dairy heifer replacement, 3-13 months 35 350 1,225
Cattle 1 daity heifer replacement. 13 months to first calf 35 E1D 2135
Cattle 1 dairy cow [6000-9000 lires milk vield) 180 101.0 18,150

Total: 18,978

Current file: PLANET England.mdb PLANET versian 3 (England & Wales) | Current Urits: Makric
— = » — . - - L - gy
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1. Select the Calendar year from the drop-down list. This is the 12 month period starting 15t
January for which you are going to enter data.

2. Enter the Area of the farm in an NVZ including the area of rough grazing land but excluding
areas of surface water, any hard-standing, buildings, roads or woodland unless the woodland is
used for grazing. You should include the area of rented land that is under your control during the
calendar year. Be careful to enter information in the same units as the current selection, i.e.
metric or imperial - you can choose the units by going to the Units menu at the top of the screen.

3. Enter the Area of the farm not in an NVZ.

4. The Total area of the farm is calculated by adding the Area of the farm inside and outside an
NVZ. The Permitted livestock manure total N capacity (only as kg N/year) for the farm is
calculated using the maximum permitted livestock manure N loading of 170 kg N/ha averaged
across the area of the farm that is in an NVZ, plus 250 kg N/ha across the area of the farm that is
not in an NVZ. If the farm has an approved derogation for the calendar year then select ‘Yes’
against Does the farm have a derogation? — the permitted livestock manure N capacity for land
that is in an NVZ will then be calculated based on the limit of 250 kg N/ha.

5. Next select the Livestock group and Livestock type for each type of livestock that you have on
the farm during the calendar year. For each Livestock type, you will first have to select the
appropriate Livestock group (e.g. cattle), then select the Livestock type (e.g. dairy cow, 6000-
9000 litres milk yield). You must include livestock kept on rented land that is under your control
during the calendar year.

6. Enter the average Number of each livestock type that are on the farm for the whole calendar
year, including livestock kept on rented land that is under your control during the calendar year. If
livestock are on the farm for only part of the year then enter the pro-rata number. For instance, if
there are 30 dairy heifer replacements on the farm for just 4 months then enter the number 10
which is the pro-rata average number for the year (30 x 4/12 = 10); this is equivalent to having 10
heifers for the whole year. For pigs and poultry where there are usually several ‘batches’ of
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livestock grown in a year, enter the number of ‘places’ on the farm — the standard values of Total
N produced for these livestock types are expressed on a per place basis . Poultry are in units of
1,000 bird places so, for example, enter 50 for 50,000 laying hen places.

7. Once you have entered details for each livestock type, the standard value for the Total N
produced by 1 unit of the livestock type is shown automatically. These are standard values that
have been set in the Regulations. The total N produced by each livestock type is calculated
automatically by multiplying the Number of livestock by the Total N produced by 1 unit. The
total N produced by all livestock on the farm is summed and appears at the bottom of the screen.
You cannot change these standard values for cattle or sheep but you can for pigs and poultry if
you have used the ENCASH computer software. ENCASH calculates a specific value for the total
N produced by a livestock type based on the specific diet and production system on your farm.

8. To delete a row of information, highlight the row by clicking on the small cell at the far left hand
end of the row then press the Delete key. If you hold down the Control key, you can select
multiple rows. To clear all the information on this tab (screen), click the right mouse button and
select Clear this tab. To clear information on all the tabs (screens) in this module select Clear all
tabs.

9. When you have entered details for all the livestock kept on the farm, click on the Imports and

Exports tab. If you have not imported or exported livestock manures during the calendar year,
click on the NVZ Compliance tab.
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Imports and Exports Tab

This allows you to enter details of any imported or exported livestock manures (if any). If you do not
import or export manures, leave this tab blank and move straight to the NVZ compliance tab.

m PLANET - Livestock Manure N Farm limit for calendar year 2010
Fle View Unks Tools Lbrary  Help

20 _avsAlN | =ncEe @

Farm Details
Calendar year 2010 E i Does the farm have demgation No

i Area of famed land in an MVZ B0.00) ha Parmitted livestack manure total M capacity 100 kgHr

L Area of faimed land not in an NYZ 2000] hg
Tatal area of famed land 10000 ha

Livestock Details NVZ Compliance

o zend the manure off your farm fails 7 Yes

Do you have details of a contingency plan to be used if a

Import/esport Date i Manure lype Quantiy i, Total N content

tornesorm?  kaftor kgdm
*
»  Impart 03/03/2010 | Pig FYM - hresh 200 70 1.400
Export 01/04/2010 | Cattle shary, mech separated liquid 270 an a0
Export 05/05/2010  Cattle FrM - fresh 250 60 1.500

Impart tatak 1,400
Expot totat 2,310
Met total: 910

Current file: FLANET England.mdb PLANET version 3 (England 8 Wales) | Current Uinks: Metric

1: start CEDBEE# s | estock... | G PLANET v3 FarmLiv., -Q:Jf. L'y, 10,05

1. If you have previously entered data into the separate Organic Manure Imports and Exports module,
you can load this data by clicking the Load data button. If you then select ‘Yes’ to loading the data,
data for all Organic manure imports for the 12 month period will automatically be imported to this tab.
Note: If you select to import data using the Load data button, this will overwrite any data that has
already been entered into this grid.

2. If you do not want to import data using the Load data button, then select Import or Export from the
Import/Export pull down list.

3. Select the Manure type that is being imported or exported from the drop-down list e.g. Broiler/Turkey
litter. Include imports onto and exports off rented land that is under your control during the calendar
year.

4. Enter the Quantity of each manure type, being careful to enter information in the same units as the
current selection, i.e. metric or imperial (you can choose the units using the Metric/Imperial menu at
the top of the screen).

5. Once a manure type has been selected, it's standard Total N content will be shown automatically.
This figure can be edited if you have undertaken specific sampling and analysis of the manure using
the standard method (see NVZ Guidance leaflet 3). If you have selected an Other manure type, enter
the total N content of this manure. The Total N (kg) of each manure type that is imported/exported is
calculated automatically. The total N (kg N/yr) imported and exported in manure is shown at the
bottom of the screen, as well as the net total (i.e. imports minus exports).

6. Click in the cell in the Supplier/Recipient column and enter details of the supplier of imported
manures or the recipient of exported manures.

7. To delete a row of information, highlight the row by clicking on the small cell at the far left hand end of
the row then press the Delete key. If you hold down the Control key, you can select multiple rows. To
clear all the information on this tab (screen), click the right mouse button and select Clear this tab. To
clear information on all the tabs (screens) in this module select Clear all tabs.

PLANET v3.3 Farm Livestock Manure N Farm Limit Help (PE).doc Page 6 of 8



8. When information for all imports and exports of livestock manures during the calendar year has been
entered, then click on the NVZ Compliance tab. You will be prompted to save any changes.
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NVZ Compliance Tab

This tab summarises the information that has been entered into the module and calculates the livestock
manure total N capacity, production and loading (metric units only) across the area of the farm.

The PLANET calculations are based on a manure total N capacity of 170 kg N/ha for all land on the farm
that is in an NVZ, plus 250 kg N/ha for all land that is not in an NVZ. See the NVZ Guidance available
from the PLANET library for further details.

[BEIE]

[ﬂ PLANET - Livestock Manure N Farm limit for calendar year 2010

 EHep TR | @

File  Wiew Units Tools  Library  Help
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Farm Details
Calendar year 2010

i fuea of famed landin an NVZ © 80.00] ha

i Area of faimed land not in an NVZ

Total area of tarmed land 100 DD. ha

i Does the fam have derogation Nio

Permitted fivestock manure total M capacity : 18600] kg N/ur

Livestock Details

Imports and Exports

NVZ Compliance

Description Area[ha) Manure total N (kg/v) !
‘Area and live stock manure total N capacity
Area of holding in an NYZ 80.00 13.600.00
Area of holding notin an NYZ 20.00 5,000.00
Total 100.00 18.600.00
Livestock manure tatal N loading E
Home-produced livestock manures
Grazing livestock 18978
Pigs and poulty ]
Imported livestock manures
Grazing livestock ]
Pigs and poultry 1400
Exported livestock manures
Grazing livestock 2310
Pigs and poLltry ]
Net total from grazing livestock 16,668
Net total from pigs and poultry 1.400
Compliance with N Farm Limit
Livestock marure total M loading over the famed area 18,068

Currert file: PLANET England. mdb

iJ start

Report

To view and print a report, select the report icon
report includes some information about this NVZ rule but further details can be found in NVZ Guidance
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"8 tnbox - w [gdeanET-

leaflet 5 ‘“The Livestock Manure N Farm Limit’.

To return to other modules in PLANET select the required icon from the task bar or use the View menu.
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from the task bar at the top of the screen. The




